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Important information 

Limitation of liability 

To the maximum extent permitted by applicable law, in no event will Carrier be liable for any lost profits or 

business opportunities, loss of use, business interruption, loss of data, or any other indirect, special, incidental, or 

consequential damages under any theory of liability, whether based in contract, tort, negligence, product liability, 

or otherwise. Because some jurisdictions do not allow the exclusion or limitation of liability for consequential or 

incidental damages the preceding limitation may not apply to you. In any event the total liability of Carrier shall not 

exceed the purchase price of the product. The foregoing limitation will apply to the maximum extent permitted by 

applicable law, regardless of whether Carrier has been advised of the possibility of such damages and regardless 

of whether any remedy fails of its essential purpose. 

Installation in accordance with this manual, applicable codes, and the instructions of the authority having 

jurisdiction is mandatory. 

While every precaution has been taken during the preparation of this manual to ensure the accuracy of its 

contents, Carrier assumes no responsibility for errors or omissions. 

Advisory messages 
Advisory messages alert you to conditions or practices that can cause unwanted results. The advisory messages used in this 
document are shown and described below. 
 

WARNING: Warning messages advise you of hazards that could result in injury or loss of life. They tell you which 

actions to take or to avoid in order to prevent the injury or loss of life. 

 

Caution: Caution messages advise you of possible equipment damage. They tell you which actions to take or to 

avoid in order to prevent the damage. 

 

Note: Note messages advise you of the possible loss of time or effort. They describe how to avoid the loss. Notes 

are also used to point out important information that you should read. 
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Chapter 1 
Introduction 

Summary 

This chapter provides a brief introduction to the KI-HDT. 
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About the KI-HDT 

Description 

The KI-HDT is a battery-operated handheld device designed to help users locate and resolve issues during 

installation or on an existing system. The tool can be used to initialize an Intelligent signaling line circuit before 

connecting it to a fire alarm control unit or it can be used to diagnose an existing signaling line circuit.  

 

The KI-HDT ships with the following accessories: 

• USB flash drive (P/N 7350094) 

• USB 2.0 A-Male to Micro B cable 

• USB wall charger 

• 10-position terminal block 

• 4-position terminal block 

• Lithium-ion battery 

The USB flash drive contains the following files: 

• Kidde Diagnostic Tool software (P/N 7351009) 

• KI-HDT Handheld Diagnostic Tool User Guide (P/N 3102576) 

• KI-HDT Release Notes (P/N 3102633) 

The Kidde Diagnostic Tool Software is compatible with Windows 7 and Windows 10. 

The KI-HDT performs the following functions: 

• Initializes the loop (i.e., identifies all devices connected to the SLC). 

• Restores the loop. 

• Performs Map Analysis on detectors and modules (contact analysis and map consistency) and identifies 

failed units (not applicable for KIR and FX Series devices). 

• Performs Dirty Level analysis on photo detectors and identifies detectors that require cleaning. 

• Allows the user to program new device address to a detector or module. (not applicable for KIR and FX 

Series devices). 
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Note: The user can use the KI-HDT to program a new device address to a new unit that can be used to 

replace a unit on a mapped enabled loop. An unprogrammed device trouble condition will still exist on a 

disabled mapped panel after a unit is replaced with a newly programmed device. 

• Perform maintenance on a single detector. 

• Reinitialize the device address of detectors or modules on a loop to zeros (not applicable for KIR and FX 

Series devices). 

• Single device diagnostics 

• Loop history, etc. 

Detectors and modules that fail contact analysis or map consistency are possible causes for map faults and map 

mismatch troubles (not applicable for KIR and FX Series devices). 

In addition, the KI-HDT can help identify the following problems: 

• Reversed IN/OUT wiring 

• Loops within loops 

• Short circuit in the SLC 

• False EOL devices or T-taps 

• Ground fault problems 

Figure 1: KI-HDT features 

 

 

(1) Antistatic silicone case 

(2) LCD touchscreen 

(3) USB port 

(4) Charging status LED (red while charging) 

(5) Communication status LED (green, blinking) 

 (6) Power button 

(7) Micro USB port 

(8) 4-pin terminal block connector (not used) 

(9) 10-pin terminal block connector (SLC) 

 

 

Charging the battery 

The KI-HDT is powered by a rechargeable Lithium-ion battery. Before using the KI-HDT, connect the battery, and 

then charge the battery for a minimum of two hours or until the red battery status LED turns off. 
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Figure 2: KI-HDT battery 

 

(1) Battery compartment cover 

(2) #2-28 × 0.25 in. Plastite screw (2X) 

 (3) Battery connector 

(4) Lithium-ion battery, 3.6V, 2200 mAh (HDT-BATT) 

To charge the battery: 

1. Remove the battery compartment cover, connect the battery to the KI-HDT, and then replace the battery 

compartment cover. 

2. Plug the USB wall charger into a 110V ac outlet, and then connect one end of the USB charging cable to the 

USB wall charger and the other end to the KI-HDT. 

Connecting the KI-HDT 

Connect the KI-HDT to the signaling line circuit (SLC) as shown in Figure 3 below. For Class A signaling line 

circuits (SLC), disconnect the wires from the A+ and A− terminals on the control unit while using the KI-HDT. 

Figure 3: Wiring 

 

(1) Connect to chassis ground on the control unit to enable ground fault detection. 

(2) From the first device on signaling line circuit. 
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Chapter 2 
A Review of Mapping 

Summary 

This chapter gives detailed overview of mapping and some causes of mapping faults on an Intelligent loop. It is 

important for users to understand the mapping process to troubleshoot effectively. Note that mapping is not 

applicable to KIR and FX Series devices. 

Content 

What is mapping?   6 

Why map a system?   6 

The mapping process   6 

The mapping process   8 

Causes of map faults   9 
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What is mapping? 

Mapping is the process by which the system determines the position and communication integrity of each device 

with respect to other devices on a signaling line circuit. 

Why map a system? 

The electrical installation (wiring) is usually performed by installers. The wiring can be more easily verified if the 

system is mapped. 

• The maintenance personnel can replace sensors without a service call if simple system maintenance is 

required. The loop controller restores a dirty/maintenance trouble if a detector is replaced with a sensor that 

matches the family type and position in the circuit that mapping is enabled. Using the KI-HDT to write a 

maintenance date to the detector can clear the maintenance trouble on the panel faster. It usually takes up to 

24 hours to clear maintenance trouble on the panel when the maintenance date is not updated with the 

KI-HDT. 

• Mapping improves overall system integrity.  

• Mapping is valuable for troubleshooting field wiring / device issues on the SLC  

The mapping process  

All fire alarm systems that support the Intelligent Series SLC use the following initialization sequence. The 

mapping process is not applicable for KIR and FX Series devices. 

• Creates a database containing the serial numbers of all devices communicating on the loop.  

• Assigns a unique short address (SA) between 0 and 255 to each serial number. 

• Detectors short address (SA) –1 to 127.  

• Modules short address (SA) –129 to 255.  

• Closes all isolator bases and isolator modules.  

Once the system has determined that no more devices are in the new start process, the mapping procedure 

begins.  

The GSA/V/KI Series mapping command is a broadcast command sent to all devices. It instructs a single, specific 

device to draw current (annunciate) while all other devices in the SLC measure the current drawn (listen). 

Depending on its location in the circuit, a detector or module can measure and report the current to the panel or 

KI-HDT Installation Tool.  

The procedure initiates the mapping command for each SLC device as the annunciating device creates a 

response table that allows the system to generate the map overview. Figure 4 shows how the SLC controller or 

KI-HDT would map devices 1 through 7. Table 1 shows the resulting map analysis. 
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Figure 4: Overview of mapping process 

                                        

 

Table 1:  Map analysis summary table 
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The mapping process  

The mapping process is not applicable for KIR and FX Series devices. 

Figure 5: Mapping detector 2 

 

 

Figure 6: Mapping detector 1 
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Causes of map faults  

What are the possible causes of map faults? The most common causes of map faults are:  

• Loose wire connections on detector bases, module terminals, at the SLC card, or at a T-tap. It’s important to 

ensure that connections are secure and that the wire at a terminal is mechanically stable. Loose connections 

cause contact resistance variations due to temperature changes, and this results in an intermittent 

connection. 

• Over-tightening a detector base onto the back box, causing it to warp, resulting in bad or intermittent 

connections with the detector head. 

• Replacing like devices in a SLC that has been left balanced. 

• Replacing devices with models that differ from the ones removed. 

• Adding new devices onto an existing SLC. 

• Rewiring an existing SLC. 

• Defective devices. 

• More T-Taps in the SLC than the maximum allowed for the system. 

• Resistance or capacitance in the field wiring more than that supported by the system. 

• Reversed polarity. Connecting the SLC+ wire to the device SLC− terminal. 

Note: When you troubleshoot map faults, be prepared to investigate and eliminate any of these causes.  

The KI-HDT can help you isolate potential mapping faults as well as contact integrity to specific devices. 
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Chapter 3 
Using the KI-HDT 

Summary 

This chapter provides detailed information about the KI-HDT to give the user a basic understanding of its 

operations. The KI-HDT can be use during installation of a new system or for diagnosing a system previously 

connected to a fire alarm control unit. 

Content 

Main Menu   12 

Initialize Loop function   13 

Restore Loop function   15 

Devices With Status screen   15 

Dirty Level function   17 

Map Analysis Function (V, KI, and GSA Series)   18 

Diagnostic Menu   21 

Settings   26 

Loop History   26 

Single Device History   27 

Saving Data to a USB flash drive   28 
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Main Menu 

The KI-HDT main menu displays all the buttons needed to aid installations and diagnosis of an Intelligent loop 

system. 

Figure 7: Main Menu buttons 

 

(1) Battery status indicator 

(2) Function buttons 

When using installation or diagnostic mode, the user must wait 30 seconds for all devices on the loop to power 

down before connecting to the panel or the KI-HDT. Disregarding this may cause problems with the detectors.  

If the loop has not been initialized on the KI-HDT, do the following: 

1. Perform the Initialize function to build the KI-HDT database. The loop initialized database is saved to the KI-

HDT memory 

2. Perform other installation functions (Map Analysis and Dirty Level). Every time a function is performed in the 

loop, the KI-HDT will update its database to reflect the information from the function 

If the loop was previously initialized and the loop was disconnected from the KI-HDT without any changes to the 

original loop, do the following: 

1. Perform the Restore function to verify the number of devices present on the loop. 

2. Perform other installation functions (Map Analysis and Dirty Level). Every time a function is performed in the 

loop, the KI-HDT updates its database to reflect the information from the function. 

Notes 

• A new database is created and saved each time the loop is initialized. 

• Always connect the KI-HDT to a charger when power falls below 20% to keep the functions working correctly. 
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Initialize Loop function 

This section describes the Initialize Loop function. To start the Initialize Loop function, tap the Initialize button on 

the Main Menu screen (see Figure 7 on page 12).  

Figure 8: Initialize Loop screen 

                                  

 

(1) Initialize button 

(2) Initialize Loop screen  

(3) Number of detector addresses found. Tap the Detectors 

button to display a list of the detector types. 

 (4) Number of module addresses found. Tap the Modules 

button to display a list of the module types. 

(5) Progress bar 

Figure 9: Initialize Loop screen (cont.) 

 

(1) Last initialized device information 

(2) Ground fault detection status 

 

  

The Initialize Loop function enables the device to perform some initial actions such as resetting all devices and 

opening all isolators. This function uses the device serial number to assign new short addresses, read device 

address, version numbers, device types, shorts on the SLC, and checks for ground fault on the SLC loop. The 

initialized data is stored in the “Stored Database Info” page of the display and can be accessed by pressing the 

Loop History button. 

(2) 

(1) 

(3) 

(4) 

(5) 

(1) 

(2) 
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The Initialize Loop process:  

1. Press the Initialize button on the touch screen.  

2. Short addresses are assigned to detectors and modules on the loop.  

3. Details of each device are displayed as the function progresses. A counter displays the total devices, along 

with a counter for detectors, modules, and/or device errors.  

4. The KI-HDT sends a command to all device to close their isolators and will attempt to find all devices again.  

5. The timeout bar shows when initialization is complete.  

6. KI-HDT erases the existing data in its memory and saves the new device data to memory. If save is 

successful, the “Saved Data” is displayed.  

7. User may press the “X” button/icon on the top right corner to stop the function at any time during the 

initialization process.  

8. Press the back button to go to the previous screen.  

9. User may press the module or device counter button when execution is complete and a new screen with a 

counter for the device types will appear. The back button on this screen will take the user back to the 

Initialization screen.  

Ground fault detection:  

1. Connect terminal 10 of the 10-POS to Chassis ground (or Earth ground). 

2. Tap the Initialize button on the Main Menu screen.  

3. Ground fault would be displayed if it exists at the KI-HDT, otherwise nothing would be displayed. 

Notes 

• Number of detectors and modules are shown after the initialize process is complete  

• Detectors and Modules buttons appear after processing is complete. Press either button to navigate to the 

detector or module type counters  

• Ground fault status would be displayed after the initialization process is complete and if there exist a ground 

fault. 
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Restore Loop function 

This section describes the Restore Loop function (see Figure 10 below). The Restore Loop function closes all 

isolators and checks the status of all devices on the signaling line circuit (SLC). To start the Restore Loop 

function, tap the Restore button on the Main Menu screen (see Figure 7 on page 12). 

Figure 10: Restore Loop screen 

                            

(1) Restore button 

(2) Status List button. Tap to display a list of devices for 

each status category. See Figure 11 on page 16. 

 (3) Number of device communicating 

(4) Restore loop page 

Devices With Status screen 

TheA Devices With Status screen (see Figure 11 on page 16) displays the list of devices for the selected status 

category. Details for each device are presented in the following order: 

<short address> <serial number> <device address> <generation> <model number> 

To display the Devices With Status screen, tap the Status List button on the Restore Loop screen. See Figure 10 

above. 

(3) 

(4) 

(1) 

(2) 
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Figure 11: Devices With Status screen 

 

(1) Back button 

(2) Status category buttons 

(3) Devices list 

  

Table 2: Device status descriptions  

Status Description 

Ready Comm Total number of devices communicating in the loop 

Trouble Devices in trouble 

Pre-Alarm Devices that are in pre-alarm 

Alarm Devices in alarm 

Supv Devices with active supervisory 

Normal Devices in normal state  

 

The Restore Loop process:  

1. Press the Restore button on the touch screen (Figure 10).  

2. Confirm if the number of devices on the Ready Comm. match the expected device address count on the SLC.  

Notes 

• User may press the Status List on the upper right corner of the Restore Loop screen to view the device status 

• Press any of the device status buttons to display a list of devices in that category 

• Restore Loop runs continuously without the screen going to sleep or timing out. Press the Back button to 

return  
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Dirty Level function 

This function is only associated with photo detectors and the function enables the user to determine the dirty level 

of each photo detector on the loop. After the successful execution of this function, the KI-HDT erases the old 

database of Dirty Levels and replaces it with the new Dirty Level data. To start the Dirty Level function, tap the 

Restore button on the Main Menu screen (see Figure 7 on page 12). 

Figure 12: Dirty Level function 

                            

(1) Dirty level button 

(2) Total number of photo detectors 

 

 (3) Dirty level percentage Tap a range to display the 

detectors and their dirty percentage (see Figure 13 below). 

(4) Number of detectors with specified dirty level 

Figure 13: Dirty Level page 

                

(1) Percent dirty level range 

(2) Percent dirty for highlighted photo detector 

  

Dirty Level Process:  

1.  Press the Dirty Level button on the Main Menu (Figure 12).  

2. Counter increments as each photo detector is read and displays dirty level information (Figure 12). 

3. User may press the “X” (cancel button) to abort the operation.  

4. Function Complete will be displayed when execution is successful, and the data saved.  

5. Press the counter cell associated with the dirty percentage to be investigated (Figure 12). 

(2) 

(1) 

(2) 

(4) 

(1) 

(3) 
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6. Press the scroll bar to see more devices on the screen (if more than 10 devices).  

7. Press a row to highlight a detector and the detector LED will start blinking or goes steady.  

8. Press the back button to return to the previous screen.  

Note: The counter cells can be pressed to see more details of the detectors within the dirty percentage range. 

Map Analysis Function (V, KI, and GSA Series) 

The KI-HDT provides two methods of investigating a new or existing loop installation and the KI-HDT helps to 

pinpoint specific devices that are causing map faults or have the potential to cause a future map fault. The map 

fault analysis function performs the following two diagnostic tests:  

• Mapping Consistency  

• Contact Analysis  
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Figure 14: Map Analysis function 

                            

 

 

 

 

                                                          

(1) Map Analysis button 

(2) Back button 

(3) Abort button 

(4) Number of units that passed inconsistent analysis 

 

 

 

(5) Inconsistent device page 

(6) Contact analysis page 

(7) Number of End of Line (EOL) mapped 

(8) Total End of Line progress bar 

Map Consistency  

The map consistency function maps each device on the Intelligent loop three times and compares the responses 

of all three readings to see if there is a mismatch. If a device is not responding consistently, it is flagged as failed 

and an investigation is required. The possible list of problems associated with inconsistent responses is discussed 

in the “Causes of Map Faults in an Intelligent loop” section. The inconsistent response screen shows the status of 

the devices being mapped and their corresponding counters as shown in (Figure 14). When the function first 

starts its execution, all devices will be displayed as passed. Subsequently, failed inconsistent devices would be 

subtracted from passed counter and added to the failed counter.  

(8) 

(7) 

(6)

(5) 

(2) 

(4) 

(3) 

(1) 
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Notes 

• The initialize function must be performed first for a new or existing loop for the KI-HDT to have a database to 

work with.  

• The user may see different responses from run to run for the inconsistence response and the panel may not 

show a map fault for this inconsistent response. 

Contact Analysis  

The contact analysis function tests the response measured by “listening” device(s) when the “annunciating” 

device is activated. The response is an indirect measurement of the contact resistance and can be used to 

identify existing mapping issues or devices that have the potential to cause an issue in the future. The user should 

refer to the list of possible problems discussed in the “A Review of Mapping” section for further information.  

Contact analysis maps each end of line device and measures the current through each device on that line. 

Map Analysis Process:  

1. Press the Map Analysis button on the main menu.  

2. The display screen shows the progress from the Inconsistent Device analysis to the Contact Analysis if 

mapping was successful.  

3. If inconsistent device analysis fails, the mapping would not progress to Contact Analysis and an Advance 

button would be displayed. Users are advised to resolve issues with inconsistencies without pressing the 

advance button.  

4. Select the failed or passed device counter to display detailed information of the devices. The highlighted 

device will flash its red LED.  

5. If the user wants to advance beyond the inconsistent device function, they can select the Advance button at 

any time. To successfully discover the End of Line (EOL) devices, the user needs to allow the complete 

execution of the inconsistent response function.  

6. Once the mapping is complete, the previously mapped data would be erased and the current mapped data 

saved to the KI-HDT memory. The screen will show “Saved Data” once the data has been successfully saved.  
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Diagnostic Menu 

The Diagnostic Menu holds functions that enable a user to run diagnostics on the Intelligent devices on the loop 

system. The functions below can be performed within the diagnostic menu screen. 

Figure 15: Diagnostic function 

                            

(1) Diagnostic button 

(2) Diagnostic menu buttons 

 (3) Diagnostic menu page 

Normalize Photo function  

This function normalizes (writes the new clean air count into memory) the photo value of the detector but it is most 

particularly helpful when a detector is cleaned after it was determined to be dirty. After cleaning the detector using 

the approved tools or method, the user can connect the detector(s) back to the loop and initiate this function to 

normalize the photo value.  

Figure 16: Normalize Function 

                            

(1) Normalize button 

(2) Number of normalized units 

 (3) Touch screen interface 

(2) 

(3) 

(1) 

(2) 

(3) 

(1) 
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The Normalize Photo Process:  

1. Press the Diagnostic button on the Main Menu.  

2. Press the Normalize Photo button after detectors have been cleaned.  

3. On the “Counter” column of the “Dirty Level” table, press the desired counter to view the new dirty level of the 

photo detectors that have been normalized. 

Note: The Normalize Photo function only applies to photo detectors. This is the same as the Recalibrate feature 

on the VS and FX panels. 

Read EEPROM Function  

The Read EEPROM function is an advanced function which may be requested by technical support or 

engineering. Refer to Chapter 6 “Advanced functions” for further details. 

Reinitialize Function (N/A for KIR and FX Series) 

This function is useful if the user needs to reset all device addresses on the loop to zero (0). 

Figure 17: Reinitialize Function 

                            

(1) Reinitialize button 

(2) Reinitialize page 

 (3) Reinitialize progress bar 

The Reinitialize Process:  

1. Press the Reinitialize button.  

2. Press the back arrow to return to the Diagnostic Menu when complete.  

3. Press the Initialize button to see updated device addresses. 

Note: Do not use this function if you do not intend to change device addresses. 

(2) 

(3) 

(1) 
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Single Device Function  

The single device function allows a user to diagnose a single device within a loop or outside a loop. Figure 18 

shows the single device button, the select single device page, and the sub-single device menu of the single 

device function. The single device function consists of five (5) sub-functions that include: Read EE data, Photo 

A/D value, Program Device Address, Program Maintenance date, and Trouble Codes. 

Figure 18: Single Device functions 

                            

 

 

 

 

                                                          

 

(1) Single device button 

(2) Back button 

(3) Select single device page 

 

 

 

 

(4) Highlighted device selected 

(5) Vertical scroll bar 

(6) Single Device menu page 

(7) Selected device serial number 

Single Device Process: 

1. Press the Diagnostic button from main menu page.  

2. Press Single Device button on the page that appears.  

3. Select the single device based on its serial number/ short address/ device address.  

(6) 

(5) 

(2) 

(4) 

(3) 

(1) 

(7) 
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Program Device Address (DA) (N/A for KIR and FX Series) 

Figure 19: Program Device Address Function 

                            

(1) Program device address button 

(2) Number of normalized units 

(3) Old device address 

 (4) New device address after function is completed 

(5) Enter keypad button to complete function 

This function is active for detectors and dual-channel devices  

1. Press the “Program DA” button to execute this function.  

2. Select the device that needs to be programmed.  

3. Enter the New Device Address using the key pad that appears.  

4. Follow the Device Addressing Guide on the screen to program the new address.  

5. Press Enter to complete action.  

6. Press the back arrow to return the “Single Device Menu” when complete.  

Notes 

• The user can only program the first address of two channel modules and the second address is programmed 

automatically. 

• The user needs to select the applicable panel type on the settings screen. 

Program Maintenance Date 

This function is useful when a user performs maintenance on a photo detector and need to update the 

maintenance date register on the detector.  

(3) 

(5) 

(1) 

(2) 

(4) 
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Figure 20: Program Maintenance Date Function 

                            

(1) Program maintenance date button 

(2) Current date populated 

 (3) Old maintenance date 
(4) New maintenance date 

1. Press the Program Maint Date button.  

2. Delete current date by pressing the “Del” key on the key pad if date is incorrect.  

3. Enter the new date (Format MM/DD/YYYY) using the key pad (Figure 20). 

4. Press Enter to complete action.  

5. Press the back button to return the Single Device Menu.  

Trouble Codes 

The trouble code function enables the user to understand the trouble condition, the possible cause, and possible 

solution to resolve the trouble. Trouble codes are displayed during the restore loop execution.  

Figure 21: Trouble Codes Function 

                            

(1) Trouble Codes button 

(2) Trouble codes page 

1. If trouble was identified during the restore loop.  

2. Press the Trouble Codes button.  

3. Read trouble code description and refer to the trouble code section of this manual for solution.  

4. Press the back arrow to return to the Single Device Menu.  

Note: Refer to the Appendix A, Trouble Codes for the list of trouble codes associated with detectors and modules. 

(3) 

(4) 
(1) 

(2) 

(1) 

(2) 
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Settings 

The Settings screen displays current date and time. The KI-HDT needs to be connected to the computer software 

to sync the time and date. The interface and GUI board versions along with the battery status, loop output voltage 

and current are displayed on this page. Press the “+” or “-“ to increase or decrease the screen brightness or 

shutdown timer respectively. The screen brightness is between 0% and 100% and default is set to 60%. The 

default shutdown timer is 10 minutes, and the Timer setting is between 10 and 70 minutes.  

The SW and HW Test buttons are advanced tools which may be requested by technical support or engineering. 

Figure 22: Settings Function 

                            

(1) Settings button 

(2) Touch screen interface 

(3) Firmware version 

 (4) Screen brightness control 

(5) Shutdown timer (Turns off device when not in use) 

(6) Loop supplied voltage and current consumption 

Note 

• Whenever the Lithium-ion battery is disconnected or replaced from the KI-HDT, it is necessary to connect to a 

computer to have the system clock synchronize to the correct time and date. 

• When the KI-HDT is first received, it is necessary to charge to full capacity in order to get the accurate battery 

percentage. 

Loop History 

The Loop History function takes the user to the Stored Database Screen; this screen shows the device 

information stored in the memory of the KI-HDT. If no actions (Initialize, map analysis, etc.) have been performed 

previously, no data is displayed in the database.  

(3) 

(6) 

(1) 

(2) 

(5) 

(4) 
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Figure 23: Loop History function 

                            

(1) Loop History button 

(2) Vertical scroll bar 

 (3) Stored database 

The following data would be populated for each device if the functions below were performed:  

Initialize: Short Address (SA), Serial Number (SN), Device Address (DA), Generation (Gen), Version, and 

Detector Type (Type) 

Dirty Level: Photo detector dirty levels (0 – 100%) 

Map Analysis: Map (Pass/Fail) 

Notes 

• An N/A will be displayed if a particular function was not performed or is not applicable. 

• When you select a device, the LED of that device will be active (blinking or steady). 

Single Device History 

The “Single Device History” displays data only when the single device Read EE Data function was performed. 

The database stores each single device’s Short Address (SA), Operation Hours (OpHrs), Alarm, Last Alarm 

Bytes, and Alarm Originator. When there is no alarm status, N/A is displayed on the Alarm, Last Alarm Bytes, and 

Alarm originator respectively.  

(2) 

(3) 

(1) 
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Figure 24: Single Device History function 

                            

(1) Single Device History button 

(2) Hours of operation of device 

 

 

(3) Vertical scroll bar 

(4) Single device history database 

Refer to Read EE Data in Chapter 5 to understand how to read single device’s EE data. 

Saving Data to a USB flash drive 

The following steps show a user how to save loop data to a USB flash drive. Each KI-HDT is packaged with a 

USB flash drive than can be used to store loop data information.  

Figure 25: Single Device History Function 

  

                     

(1) Save button icon 

(2) Space to enter file name 

 (3) Keypad buttons 

 

(2) 

(3) 

(1) 

(4) 

(2) (1) (3) 
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1. Connect the USB flash drive to the KI-HDT USB port.  

2. A disk icon will appear (Figure 25). 

3. Press the disk icon.  

4. Enter a name for the file to save by using the keypad that appears (30 characters maximum input).  

5. Press Enter to complete saving the data.  

6. Confirm icon appears (“100% progress bar” and “Data saved to USB” text).  

7. Unplug the USB and access the report from a computer. 

Notes 

• Do not plug both a USB device and charging cable to the KI-HDT at the same time. This will cause damage to 

the micro USB connector on the KI-HDT and may result in intermittent contact issue when usb is plugged 

• The default format of the USB device that comes in the box of the KI-HDT is a FAT. If the save icon does not 

appear when a USB flash device is inserted, format the USB flash to FAT using a Windows PC. Make sure to 

transfer all your files from the USB flash device before formatting because all files in the drive will be deleted. 
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Figure 26: KI-HDT Report Data 

 

(1) Total number of devices found in the loop 

(2) Devices found and their information 

(3) Dirty level of photo detectors 

(4) End of Line device with information 

(5) Mapping contact analysis result 

 (6) Complete mapping result 

(7) Ground fault detection result 

 

(6) 

(1) 

(2) 

(3) 

(4) 

(5) 

(7) 
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Chapter 4 
Using the Kidde Diagnostic 
Tool Software 

Summary 

This chapter provides detailed information about the Kidde Diagnostic Tool software that comes with the KI-HDT. 

This application can be installed from the USB flash drive found in the KI-HDT box or it can be downloaded and 

installed from the My-Eddie website. 

This chapter will provide information on the installation of the software, the steps to update the KI-HDT GUI and 

Interface firmware, and the functionality of the different buttons of the software. 

Content 

Installing the KI-HDT PC Software   32 

Updating the KI-HDT firmware   33 

Functions (Buttons)   34 

Initialize   35 

Restore   36 

Read all EEPROM   36 

Map   37 

Map Fault Analysis   38 

Dirty Detection   39 

STOP   41 

Importing data from the KI-HDT   41 

Saving imported data   43 
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Installing the KI-HDT PC Software 

The KI-HDT comes with a PC software that is used for firmware update as well as importing data from the device 

and saving the report to a PC.  

The steps below will guide the user on the installation of the PC software  

1. Remove the USB flash device from the KI-HDT Box and insert to a computer. 

2. Nagivate to the USB flash drive on your computer. 

3. Double click on “Install_KI-HDT.exe” file to start installation. 

Figure 27: PC Software Installation 

            

 

 

 

            

 

 

 

 

(1) Next button to start installation 

(2) Agree button  

 

 

(3) Next button to confirm location 

(4) Install button to start the installation 

(1) (2) 

(3) (4) 
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Updating the KI-HDT firmware 

Updating the KI-HDT firmware to the latest revision may require you to update the interface board firmware, the 

display (GUI) firmware, or both. 

To see which firmware versions the KI-HDT is running: 

1. Turn on the KI-HDT. 

2. On the Main Menu screen, tap Settings. 

If the firmware is not the latest versions, go to the My-Eddie website to download the latest, and then follow the 

instructions below. 

Updating the interface board firmware 

1. Start the Kidde Diagnostic Tool software.  

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software.  

3. Turn on the KI-HDT, and then wait for the software to connect.  

4. Click Tools > Update Interface Firmware. 

 

5. In the USB Bootloader app, after the “Bootloader Ready" message appears, click Program File. 

 

6. Select the firmware hex file downloaded from the My-Eddie website and wait for the progress bar to show 

100% with the screen display “Erase/Program/Verify sequence completed successfully!”  

7. Close the USB Bootloader app to restart the KI-HDT.   
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Updating the GUI Firmware  

1. Start the Kidde Diagnostic Tool software.  

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software. 

3. Turn on the KI-HDT, and then wait for the software to connect. 

4. Click Tools > Update GUI Firmware. 

 

5. The screen will display Bootloader as shown below. If the screen displays “Fails to get a response”, the user 

needs to click the “Advanced” button to display the Reset to Boot button. Refer to Chapter 5 

“Troubleshooting” for guidance on how to troubleshoot issues with firmware update.  

6. In the GUI Bootloader app, click Program File.   

 

7. Select the GUI Firmware hex file downloaded from the My-Eddie website and wait for the progress bar to 

show 100% with the screen display “Erase/Program/Verify sequence completed successfully!”  

8. Close the GUI Bootloader app to restart the KI-HDT.   

Functions (Buttons) 

There are a total of eight (8) loop buttons on the Kidde Diagnostic Tool software that can be used for executing 

specific functions. Each function during execution can be aborted by using the “STOP” button function. The 

Initialize function is the first function that must be executed before other functions can be utilized. 
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Figure 28: KI-HDT Function buttons 

 

Initialize 

The Initialize function shows the number of devices found on the loop with device info such as serial number, 

device address, short address, firmware version, and manufacture date. 

To start the Initialize function: 

1. Click the Initialize button and wait until all devices on the loop are seen on the information area. 

2. Wait until you see “ Operation complete” on the information area. 

3. Verify that all devices expected are initialized; troubleshoot the loop if necessary. 

Figure 29: Initialize Function 
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Restore 

The Restore function executes its operation by displaying the list of devices currently communicating, devices in 

Alarm, devices in Pre-Alarm, and devices in Trouble. 

To start the Restore function: 

1. Click the Restore button and wait until all devices on the loop are seen on the information area. 

2. Verify that all devices expected are initialized; troubleshoot the loop if necessary. 

3. Click the STOP button to stop the process. 

The green rectangular box indicates active device short addresses, and the purple box indicates device short 

addresses that are not active on the loop. 

Figure 30: Restore Function 

 

Read all EEPROM 

The Read all EEPROM function gives a user the capability to read all device register values present on the loop. 

This data is only useful to a Kidde engineer for advanced troubleshooting. Note that technical support agent could 

request that you run this function and send the report to them. 

To start the Read all EEPROM function:  

1. Initialize the loop first if you have not done so. 

2. Click the Read all EEPROM button. 

3. Wait for the function to execute (time varies depending on the number of units on the loop). 

Note: The EEPROM info page on the software displays the total number of devices on the loop. 
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Figure 31: Read all EEPROM  

 

Map 

The Map function creates a map of the devices connected to the loop and it also displays a tree diagram of all 

devices with their serial numbers, short addresses, device types etc. See Figure 32 on page 38. 

The information area on the left shows the map tree information with the ability to expand and collapse the end of 

line(s) device(s). The information area on the right shows additional device information such as device 

manufacture date, serial number, firmware version, etc. The information on the right of can be copied to word 

processor, text editor, or spreadsheet (i.e., Word, Notepad, Excel) 

To start the Map function: 

1. Click the Initialize button first to bring all devices on the loop to the database of the tool. 

2. Click the Map button to start the function. 

3. Wait for function to complete execution. 
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Figure 32: Map Tree 

 

Map Fault Analysis 

The Map Fault Analysis function in the Kidde Diagnostic Tool software (see Figure 33 on page 39) is like the Map 

Fault Analysis function on the KI-HDT. Additional information is also displayed in the information area of the Map 

Fault Analysis. For more information, see"Map Analysis Function (V, KI, and GSA Series)" on page 18. 

To start the Map Fault Analysis function: 

1. Click the Initialize button first to bring all devices on the loop to the database of the tool. 

2. Click the Map Fault Analysis button to start the function. 

3. Wait until function is complete. 

4. Copy or Save the Map Fault Analysis report as required. 
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Figure 33: Map Fault Analysis function 

 

Dirty Detection 

The Dirty Detection function reads the dirty levels of all photo detectors on the loop and displays the dirty percent 

in the information area of the software. 

To start the Dirty Detection function: 

1. Click the Dirty Detection button. 

2. Wait until function is complete. 
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Figure 34: Dirty Detection Function 
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STOP 

The STOP function aborts the current function being executed.  

To stop a function: 

1. While the function is running, click the STOP button. 

Figure 35: STOP Function 

 

Importing data from the KI-HDT 

The user can import three categories of data:  

• Device(s) EEPROM Data  

• KI-HDT Report Data  

• Single Device Data  

The KI-HDT Report contains all the device information, the dirty level for each photo detector on the loop and the 

mapping data as shown in Figure 26.  

To import device EEPROM data:  

1. Start the Kidde Diagnostic Tool software. 

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software. 

3. Turn on the KI-HDT, and then wait for the software to connect. 

4. Click File > Import KI-HDT Data > Devices EEPROM. 

5. Wait for import to complete before exiting. 
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KI-HDT Import Report Process  

The process of importing data from the KI-HDT to the PC software is straight forward and relatively easy. This 

function imports the loop data saved in the KI-HDT internal memory to the Kidde Diagnostic Tool software. 

Figure 36: KI-HDT Import Report Process 

 

Figure 37: KI-HDT Report Data 

 

To import KI-HDT reports:  

1. Start the Kidde Diagnostic Tool software. 

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software. 

3. Turn on the KI-HDT, and then wait for the software to connect. 

4. Click File > Import KI-HDT Data > Get KI-HDT Reports. 

5. Wait for import to complete before exiting  

Single Device Data Process   

This function imports the single device history data saved in the KI-HDT internal memory to the Kidde Diagnostic 

Tool software. 
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Figure 38: Single Device Report Process 

 

Figure 39: Single Device Report Data 

 

To import single device data:  

1. Start the Kidde Diagnostic Tool software. 

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software. 

3. Turn on the KI-HDT, and then wait for the software to connect. 

4. Click File > Import KI-HDT Data > Single Device Data. 

5. Wait for import to complete before exiting  

Saving imported data  

The data files imported from the KI-HDT can be saved to your computer.  
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Figure 40: Saving Imported Report 

 

Figure 41: Report Location 

 

To save data files:  

The user can save imported device data in the Kidde Diagnostic Tool software to a computer by following the 

steps below.  

1. Start the Kidde Diagnostic Tool software. 

2. Using the USB cable shipped with the KI-HDT, connect the KI-HDT to the computer hosting the Kidde 

Diagnostic Tool software. 

3. Turn on the KI-HDT, and then wait for the software to connect. 

4. Import the loop report. See "Importing data from the KI-HDT" on page 41. 

5. Click File > Save File. 

6. In the Save Text File dialog box, go to the target destination folder, and then click Save.  
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Chapter 5 
Troubleshooting 

Summary 

This chapter covers troubleshooting cases when certain issues arise on the loop or during firmware update. 

Content 

GUI Bootloader non-responsive   46 

Low current difference value   47 

Reversed IN/OUT wiring   49 

Loop-in-a-loop   50 

False end-of-line device   52 

Map   52 

Reports   53 

Ground fault detection   54 
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GUI Bootloader non-responsive 

No Response from GUI Bootloader  

If there is no response from the GUI Bootloader and a user is unable to update the firmware, the user can reset 

the Bootloader by following the steps below: 

Figure 42: GUI Bootloader Advanced Option 

 

(1) Advanced button 

(2) Bootloader response 

 (3) Firmware update progress bar 

Figure 43: Active Advanced Screen 

 

(1) Reset button 

(2) Touch screen interface 

 (3) Program File button 

 
Troubleshooting steps:  

1. Click the “Advanced” button (Figure 42).  

2. Click the “Reset to Boot” button (Figure 43).  

3. Click “Version” to verify that the version number is displayed.  

4. Program File button becomes active.  

(1) 

(2) 

(1) 

(3) 

(3) 

(2) 
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5. Click on “Program File” and locate the firmware hex file to start the update.  

6. Close GUI Bootloader when complete.  

Low current difference value  

Note: Not applicable for KIR and FX Series devices. 

Map 

In this troubleshooting example, both analysis methods (map consistency and contact analysis) are used for a 

simple class B circuit with modules and T-taps to detect devices with low current difference (DIF). Devices 

reporting a DIF value of 5 or less need to be investigated. 

Figure 44: Low current difference device 

 

Reports 

Devices with a current DIF value of less than or equal to 5 are flagged as failed. They are also shown in the report 

summary imported from the KI-HDT. 
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Figure 45: Report for low current difference devices 
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Reversed IN/OUT wiring  

When wired correctly, detectors report a positive DIF value; modules report a negative DIF value. When the IN- 

and OUT- of a device are reversed, the opposite is true. Incorrectly wired detector bases report a negative 

DIFvalue. Incorrectly wired modules report a positive DIF value. 

Note: Not applicable for KIR and FX Series devices. 

Figure 46: Reversed base report 

 

(1) A negative DIF result is reported for a detector with 

reversed IN and OUT connections 

(2) Negative DIF results are also reported for correctly wired 

modules 
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Loop-in-a-loop  

Note: Not applicable for KIR and FX Series devices. 

Map 

A loop-in-a-loop occurs when two devices on a separate T-tap are wired together. The devices in the inner loop 

report half their normal DIF value. Contact analysis is useful in detecting a loop-in-a-loop. 

Figure 47: Devices wired together to form a loop-in-a-loop 
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Reports 

All devices in a loop within a loop are flagged as failed in the report. Devices outside the loop are not flagged. 

Figure 48: Report for a loop-in-a-loop 
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False end-of-line device  

In this troubleshooting example, the contact analysis method is used for a simple class B circuit with modules and 

T-Taps. 

The mapping analysis report shows an unexpected end-of-line device, but this is only apparent when compared to 

the expected (original) CU or SDU map and statistics. 

Note: Not applicable for KIR and FX Series devices. 

Map 

Figure 49: Maps showing a false T-tap and end-of-line device 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(1) Original map 

(2) False T-tap and end-of-line map 

 (3) False end-of-line device 
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Reports 

The following process can be used to investigate a device with false T-tap and end-of-line device in the map. 

To troubleshoot false end-of-line devices: 

1. Use the original CU or SDU map (prior to the map fault or map mismatch trouble) to get the end-of line device 

addresses (from the map) and the T-tap count (from the map loop statistics). 

2. Uploaded the current map from the SLC that is reporting the map fault or map mismatch trouble. 

3. Use the current map to get the end-of-line device address (from the map) and the T-tap count (from the map 

statistics). 

4. Use the KI-HDT report (the sections of the end-of-line devise) to identify the device addresses that are not 

actual end-of-line devices. 

5. Investigate the devices identified as false end-of-lines for the issues listed in “Causes of map faults” on page 

8. 
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Figure 50: Maps showing a false T-tap and end-of-line device 

 

(1) Device address 58 does not belong in the EOL device group 

(2) Device address 58 was analyzed as an end-of-line device error 

  

Ground fault detection 

There are two ways the KI-HDT notifies users of a ground fault. The ground fault status is only displayed on the 

Initialize Loop page during initialization and when there is a ground fault at the KI-HDT. 

First, connect Pin10 of the HDT terminal block to Chassis ground of your panel. 

1. The KI-HDT checks the terminal blocks of the KI-HDT for possible ground faults. 

2. The KI-HDT checks for negative ground fault each time an isolator closes. 
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Figure 51: Ground Fault check during Initialization 

                                 

 

(1) Ground Fault check at KI-HDT connector 

(2) Timeout bar 

  

Note: The KI-HDT notifies the user of a negative ground fault before a specific serial number (i.e. SN:xxxxxxxx) 

when there is an isolator device on that loop and it reports ground fault without specification to a serial number for 

a positive ground fault. 

 

 

  

(1) 

(2) 
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P/N 3102576-EN • REV 002 • ISS 02NOV22 57 

Chapter 6 
Advanced functions 

Summary 

The chapter covers advanced functions needed by technical support for advanced troubleshooting. 

Content 

Read Device EEPROM   58 

Read EE Data   60 

A/D Value   61 
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Read Device EEPROM 

The Read EEPROM function is an advanced function which may be requested by technical support or 

engineering. The data produced by this function may be requested by technical support or engineering to 

remotely resolve an issue. This function allows a user to read EEPROM from the entire loop or from a single 

device.  

Figure 52: Read EEPROM Function 

                            

(1) Read EEPROM button 

(2) Select Read EEPROM page 

 (3) Read selection buttons 

(2) 

(3) 

(1) 
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Figure 53: Select Read EEPROM Function 

                

                                                                                              

 

(1) Select single device list page 

(2) Read all EEPROMs page 

 (3) Current device information 

Figure 54: Read EEPROM Function 

                 

 

 

 

 

(1) Serial number of unit 

(2) Device address 

(3) Generation of unit 

 

 

 

 

(4) Unit firmware version 

(5) Unit type 

(6) Save Data text 

(2) 

(1) 

(6) 

(5) 

(1) (2) (3) (4) 
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The Read EEPROM Process:  

1.  Press the Diagnostic button on the main menu screen.  

2.  Press Read EEPROM.  

3.  To Read Full Loop  

 •  Press the Read Full EEPROM button to execute the read EEPROM of full loop (more than one device).  

4.  To Read Single Device  

 • Press the Read Single Device button on the Select Read EEPROM page.  

5.  Select the device to be read (Figure 48) and the process of reading the EEPROM will start immediately.  

Read EE Data 

The Read EE Data function is an advanced function which may be requested by technical support or engineering.  

Figure 55: Read EE Data Function 

                            

(1) Read EE button 

(2) Unit EEPROM information 

 (3) Confirmation of data saved to KI-HDT database 

1. Press the Read EE Data to perform this function.  

2. Press the back button to return to Single Device Menu when data has been saved.  

Notes 

• Many of the single device functions are advanced functions used by technical support or engineering to 

provide additional support to users in the field 

• This function displays some information such as the device serial number, device type, last Alarm hour, hour 

of operations, and dirty level 

(2) 

(3) 

(1) 
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A/D Value 

A/D Value  

The A/D values of a detector is an advanced function that may be requested by technical support or engineering 

to determine if the current A/D values of a detector are too high.  

Figure 56: A/D Function 

                            

(1) A/D button 

(2) Current clean air values 

 (3) Baseline photo value 

1. Press the “A/D Value” to execute this function  

Note: This function takes twelve (12) dynamic readings, each of the Photo, Heat, and/or CO values of the 

selected detector. The baseline photo clean air value programmed into the detector at the factory is also 

displayed. This function allows an advanced user to see how the current photo clean air, heat, and/or CO values 

are drifting.  

(2) 

(3) 
(1) 
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Appendix A 
Trouble Codes 

Summary 

Appendix A gives detailed description of the trouble conditions for detectors and modules and how to resolve 

them. 

Content 

Detector trouble codes   64 

Module trouble codes   65 

Device trouble codes   66 
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Detector trouble codes 

Table 3: Detector trouble codes 

Trouble Condition Possible Cause Possible Solution 

EEPROM empty EEPROM falsely programmed Replace the detector 

EEPROM timeout EEPROM defective Replace the detector 

Wrong type of det. Programmed 
EEPROM falsely programmed or not 
programmed 

Replace the detector 

EEPROM verify error EEPROM defective Replace the detector 

Outside light error 
Foreign materials in the light 
chamber, or direct light is radiating 
into the chamber 

Clean detector, or eliminate 
the direct light source 

Quiescent value threshold O sensor 
exceeded  

Detector is dirty Clean detector 

Quiescent value threshold O sensor not 
met   

Detector is dirty Clean detector 

Filtered O test value too big Electrical defect on the device base 
Check the wiring of the base 
or replace the base 

Filtered O test value too small Electrical defect on the device base 
Check the wiring of the base 
or replace the base 

Ion chamber test value slope too steep 
Electrical defect in the ion chamber, 
or programmed quiescent value too 
small 

Replace the detector 

Quiescent value threshold I sensor 
exceeded  

Detector is dirty Clean detector 

Quiescent value threshold I sensor not 
met 

Detector is dirty Clean detector 

I test value too small Detector is defective Replace the detector 

T test value too big Electrical defect on the device base 
Check the wiring of the base 
or replace the base 

T test value too small Electrical defect on the device base 
Check the wiring of the base 
or replace the base 

A/D convert.timeout      A/D converter defective Replace the detector 

SOC amplit. too small Ion sensor failure Replace the detector 

SOC decay too fast Ion sensor failure Replace the detector 

SOC decay too slow Ion sensor failure Replace the detector 

Quiescent current too large dur. vector 
mes. 

Devices on the SLC data circuit are 
drawing too much current during the 
mapping procedure 

Check the wiring of the 
detector or replace the module 

Quiescent current too small dur. vector 
mes 

Devices on the SLC data circuit are 
not drawing enough current during 
the mapping procedure.  
Excessive circuit resistance 

Check the wiring of the 
detector or replace the module 
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Trouble Condition Possible Cause Possible Solution 

Short on Relay base Relay base is defective Replace the base 

Relay or isolator does not switch Relay/Isolator base is defective Replace the base 

Relay or isolator toggled 
Relay base is defective 
External electrical noise 

Exchange the base or remove 
shield/noise source 

Short circuit on external D line Short circuit on SLC line 
Locate and remove cause of 
short 

Open circuit on external D line Short circuit on SLC line 
Locate and remove cause of 
short 

Error with transmitted light measurement Detector is dirty Clean the detector 

Det. has switched into short circ Short circuit on SLC line 
Locate and remove cause of 
short 

CO not calibrated EEPROM defective Replace the detector 

CO end of life Reached EOL 
Replace the CO sensor or 
Detector 

CO sensor failed Detector is defective Replace the detector 

CO communication (UART) failed Detector is defective Replace the detector 

 

Module trouble codes 

Table 4: Module trouble codes 

Trouble Condition Possible Cause Possible Solution 

EEPROM empty EEPROM not programmed Replace detector 

EEPROM timeout EEPROM defective Replace the detector 

AD timeout     

EEPROM verify error  EEPROM defective Replace the detector 

Line monitor trouble 
Monitor input circuit was outside normal 
range 

Check the wiring of the Loop 
Controller data circuit 

Class A trouble Open or shorted input/output circuit 
Check the wiring of the input/output 
circuit 

Third wire trouble 
Actual voltage on the 3rd wire used to 
supply 24 VDC to the GSA-UM is < 22 VDC 
or > 27 VDC 

Check the power supply output 
Check the wiring of the module 

Memory fail The module's on-board RAM is faulty Replace the modules 

Vector too big 
Devices on the SLC data circuit are 
drawing too much current during the 
mapping procedure 

Short or low resistance shunt on 
SLC data circuit 

Vector too small 

Devices on the SLC data circuit are not 
drawing enough current during the mapping 
procedure.  
Excessive circuit resistance 

Check the wiring of the module or 
replace the module 
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Trouble Condition Possible Cause Possible Solution 

CH1/CH2 open circuit 
See Module in Trouble on Host Controller 
in Appendix B 

See Module in Trouble on Host 
Controller in Appendix B 

CH1/CH2 short circuit 
See Module in Trouble on Host Controller 
in Appendix B 

See Module in Trouble on Host 
Controller in Appendix B 

CH1 relay trouble 
See Intelligent Series Module 
Troubleshooting Matrix Below 

See Intelligent Series Module 
Troubleshooting Matrix Below 

CH1/CH2 ground fault 
See Module not responding correctly in 
Appendix B 

See Module not responding correctly 
on Appendix B 

 

Device trouble codes 

Table 5: Device trouble codes 

Trouble Condition Possible Cause Possible Solution 

Communication Error (Comm error) Faulty Device, wiring, bad contacts on 
base, EMF 

Check wiring, devices, and contacts 

Short Error Wire short Remove any short on wire 

Ground Fault error Ground Fault on positive or negative 
wire 

 

Duplicate Device Address (Rotary only) Rotary setting Adjust rotary dial to remove duplicate 
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Appendix B 
Intelligent Series Module 
Troubleshooting Matrix 

Summary 

Appendix B shows the troubleshooting matrix for the intelligent series modules. 

Content 

Troubleshooting Matrix   68 
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Troubleshooting Matrix 

Table 6: Module not responding correctly 

CC1 CC2 CR CT1 CT2 MM1 UM WTM Possible Causes 

X X X X X X X X Module installed in wrong location or improperly 
addressed 

X X X X X X X X Module not entered into Loop Controller 
database 

X X - X X - X - Incorrect personality code loaded into module. 

- - - - X - X - Personality code for unused portion of module 
not set to 0. 
Personality Codes 1, 2, 3, 4, 8, 13, 14, & 16) 

- - - - - - X - Jumper JP1 set incorrectly. (P-Code 8) 

- - - - - - X - 24 VDC for smoke power low or missing. 
(Personality Codes 3, 14, 20, & 21) 

- - - - X - X X Inputs 1 & 2 swapped. 
(Personality Codes 1, 2, 3, & 4) 

- X - - - - 

  

Signal sources 1 & 2 swapped. 
(Personality Code 7) 

X X X X X X X X Ground Fault on data circuit or (-) side of 
input/output circuit 

 

Table 7: Module in trouble on host controller 

c CC2 CR CT1 CT2 MM1 UM WTM Possible Causes 

X - - X X X X X Module missing or mis-wired on Loop Controller 
data circuit. 

X - - X X X X X Mapping error. Module not loaded into Loop 
Controller 
database. 

X 

  

X X X X X Ground Fault on input or output circuit. 

X X - - - - X - Output circuit open, shorted, mis-wired, polarized 
device installed in reverse, incorrect or missing 
EOL resistor. 

- - - X X X X X Missing or incorrect EOL resistor. 
(Personality Codes 1, 2, 3, 4, 13, 14, 16, 20, 21) 

        

Internal module fault. 

- - - - - - X - 24 VDC for smoke power low or missing. 
(Personality Codes 13, 14, 20, & 21) 

 

Table 8: Module incorrectly in alarm/active on host controller 

CC1 CC2 CR CT1 CT2 MM1 UM WTM Possible Causes 

- - - X X X X X Initiating Device Circuit shorted or initiating 
deviceincorrectly installed. 

- - - X X X X X Incorrect EOL resistor value (too low) 

 


